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What's covered?

Printed Output covers how to set up a printed output in RoboHelp. This page is about what to do
when things go wrong. These are some of the things to check.

o Lists
¢ Missing_Topics

o Duplicated Topics

o Word Issues

e Other Issues

June 2019 - This page covers issues related to RoboHelp Classic versions up to and including

RoboHelp 2019 Classic.

Lists

Bulleted and numbered lists may not appear with the same indentation or they may not be true
lists. See Single Level Lists for information about that.

Missing / Duplicated Topics

Sometimes the output does not contain the topics you have specified, sometimes it contains them

more than once.

Missing Topics

Cause

Description

Topics created from import
of a Word document

When you import topics from a Word document into RH HTML, the
html code you get is bloated. This causes all sorts of problems and
the sort of thing that goes wrong is covered in Importing Word
Documents. There I explain how I clean up any Word documents
that I have to import.

One poster sent me a copy of their project where various topics
were in the print layout but not the final document. Eventually I
identified the cause. I found variations of <![if
IsupportEmptyParas]> in topics preceeding the missing topics, as
shown below. That is something that Word generates when creating
an html version of a doc file. After removing all instances, the topics
all printed fine.

Remember, this will be found in topics other than those that do not
print. It may also be found in the non printing topics. Below are the
variations I found, you may find others.

The real answer is clean up your code after importing from Word.
Otherwise you never know when it will bite back and it may be so
long afterwards that it is the last thing you think of.

<I[if 'supportEmptyParas]>
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<I[if 'supportEmptyParas]><![endif]>
<I[if !supportEmptyParas]>&nbsp;
<I[if 'supportEmptyParas]>&nbsp; <![endif]>

I have also been told the same issue occurred with the following
code from a Word document.

<p class="ListBulletl" style="mso-bookmark: _Toc423446978;">
<span lang="EN-AU" xml:lang="EN-AU">/p>

Build tags

If the print layout has a build expression applied, then the topics
excluded by that expression simply will not print. You can include
them in the layout by using the Show All Topics check box, but they
will not print.

At first it may seem silly to allow you to include topics that cannot
be printed but it is actually very useful. The idea is that you have
the ability to define one layout and then choose to run it with or
without the build expression. With the build expression applied you
get the short version, without it you get the full version.

See Printed Output.

Style Sheet Conflict

With one project sent to me it would only print all the topics in the
layout even if all the paragraph styles were set to normal.
Eventually the poster found that by changing back the styles from
normal to what they should be, it went bang with one particular
style. Once that was removed, everything printed fine.

Project on network

Over the years and in the various incarnations of the forum, there
have been lots of posts where the cause has been running the
project across a network. Put the project on the hard disk and it
works as intended.

Often when this is stated on the forum, someone will say "I've had
my projects on a network drive for years and not had any trouble".
You can play Russian Roulette and win some real big money but
eventually that bullet is going to get you.

It amuses me that sometimes those who defend this are the very
people having a problem.

Note that I am not referring here to projects under source control on
a network, that is totally different.

Update - RoboHelp 10 and above allow projects to be stored on a
network but do generate your printed output to the same drive.

Outputting to network

The same argument as above.

Long path and file names

There is some evidence that long path and file names for the topics

going into the print layout can cause problems. I haven't been able

to substantiate this but if all else has failed, be guided by those who
have had the problem.

Topic not included in the
layout

The default layout the very first time you create a printed document
is the online TOC. As a result it is sometimes expected that changes
to the online TOC are reflected in the print layout. They are not. See
Printed Output.

Malformed topics message

I haven't seen this problem reported for quite some time now but
occasionally people used to report that they got a Malformed Topics
message and no content appeared or they got some duplicated
topics but not the whole layout.
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Initially the reported problems were resolved by using the supplied
Style Mapping template instead of the user's own template, even
though no fault could be found with the user's own template. I
would just add that I automatically now suggest using the supplied
Style Mapping template as it fixes so many problems that get
reported. Back up the supplied template as a precaution and then
edit to suit your needs.

In one case though even using the Style Mapping template did not
resolve the problem. Here I found that by changing the CSS file
attached to all the topics, the problem was solved. The CSS file used
had a gif image for bullet points and that seems to have been the
problem. Using a copy of your project, it is worth changing the CSS
file used to one of the supplied CSS files that has not been modified
in any way to see if that fixes the problem.

I also ran into the problem and found that the paragraph after a
bookmarked heading contained the following code:

<p style="mso-bookmark: REQ_Requisitions_Link_Menu;">

That looks like something from Microsoft Word and when I removed
it, the document was generated without problems.

Update: I encountered this problem again using Adobe RH7 but
none of the fixes here worked. By applying the Output view, I
noticed that the problem started at a particular point and then
continued. When I deleted all the topics after that point, it was OK.
Then I generated another layout starting with all the topics after
that point. Suddenly they started working but again it reached a
point further on where the problem occurred again. This was
beginning to look like a resource issue so I put the project on a
much more powerful machine with 3gb of ram and it generated
perfectly, all 1,500 pages!

Same topic prints twice

This often occurs when authors link a topic to a book so that clicking
the book in the online help opens a topic without the user having to
select the topic. Sometimes the author will also list the topic so that
users can see it listed as there is no indication to the user that a
topic is linked to a book.

If that TOC is used for Printed Documentation, the topic is in the
layout twice. Once from the book layout and once from its own
listing. You simply delete the listing in the topic and it will only be
included once.

From RoboHelp 9 things changed. Adobe made it more obvious by
showing the topic linked to a book as a listing and then showing it
again. Scroll down the TOC in the Printed Documentation layout and
check for duplicates below the books.

Duplicated Topics

Cause

Description

Style Sheet Conflict

You will notice this cause is also listed under Missing Topics as it can
cause both problems. What happens here is that the document
starts to print normally but after a number of topics are generated
correctly, it then reverts to the start of the layout, duplicates some
topics and then stops.

The cause is the same, there is something in the style sheet that
causes to generation to fail to work properly.

To find out if this is the cause is quite easy. Take a copy of your
project using Windows Explorer. Using the copy apply a completely
different style sheet to all topics. Generate again and if the problem
has gone away, you know the cause.

https://www.grainge.org/pages/authoring/printing/print_issues.htm

3/12



16/12/2023, 13:08

Print Issues

To find out which particular style is the cause is more time
consuming than difficult.

1. Have you got an older copy of the style sheet? Does it make
any difference? What are the differences between the old and
new version?

2. Gradually import into the temporary style sheet the individual
styles from the one causing the problem and keep generating
documents until the problem comes back.

Word Issues

This section brings together the various issues previously covered within Snippets on this site plus

new ones as found.

Issue

Description

Cannot find Microsoft
Word installed on your
system

RoboHelp 7, 8 or 9 Problem

If you get this message in RoboHelp 7, 8 or 9, please email me requesting

MPJ2DOC.ZIP.

It is important you state for which version of RoboHelp you
require the file and the version of Word that you are using.

The file contains a replacement DLL that should be saved to C:\Program
Files\Adobe\Adobe RoboHelp nn\RoboHTML assuming you used the
default installation. Rename the old file first.

Update 30 Dec 2012

Mark Kofler found an alternative solution which he posted on the

RoboHelp forum. It is too early to tell whether this will work for everyone.

Coincidentally I saw a similiar solution elsewhere but with slightly
different instructions.

Alternative Method
In Windows 7, press the Windows key and the letter R.
Type "cmd" (without the quotes) and press Enter.

Type "winword.exe /r" (without the quotes but noting the space before
the backslash) and press Enter.

If that fails, in the Command window enter
cd "C:\Program Files\Microsoft Office2010\OfficeNN (on 32 bit systems)

cd "C:\Program Files (x86)\Microsoft Office2010\OfficeNN (on 64 bit
systems)

where NN is your version of Word.

Word 2010 = 14

Word 2007 = 13

Then enter "winword.exe /r" again and press Enter.

Please let me know if either method works or fails for you.

Open Office Conflict

David Channon posted that he could generate printed documentation
from RoboHelp for Word but if he tried from RoboHelp HTML, he got a
message "Cannot find Microsoft Word installed on your system".
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The problem turned out to be not the fact that David had Open Office
installed but the way in which it was installed.

When installing OpenOffice there is an option to automatically open doc
files in OpenOffice. If that option is selected during installation, the
problem that David encountered arises. My first thought was that this was
simply because doc files had been associated with OpenOffice. However,
changing those and dot files back to Word did not solve the problem. You
have to uninstall OpenOffice and reinstall it making sure the option is not
selected. Then RH HTML generates the printed output without problems.

For anyone who does not frequently generate printed output, I suspect
you could install OpenOffice with the option deselected and then use
Windows Explorer to associate doc files with OpenOffice, changing that to
Word when required. Not tested.

Citrix

Lola Little posted an entirely different reason

"I am on a machine that was set up to conenct to Citrix to access MS
Word. As a test I dropped a Word file on my desktop - I clicked to open it
and it goes through Citrix instead of using the local copy of Word- so it
makes sense the RoboHelp wouldn't be able to find my local copy of
Word. I'm in the process of working with my sys admin to look into this
further.

Update- the sys admin disabled the citrix agent - the citrix icon no longer
appears in the system tray. This also causes the .DOC extenstion to be
associated with the local copy for Word instead of the Citrix copy. Next he
rebuilt my profile. Works now!"

Missing Images

R Kohler posted that images were not appearing in their printed document
and nothing here had helped. Later they posted:

I discovered that the images that were missing in the printed doc were
surrounded by H3 tags instead of P tags. I replaced the H3 tags with P
tags and now all the images show up in the printed doc.

Worth checking out.

James Skaggs reported:

There is a fix on the Adobe Web site for printed documentation issues
whereby several DOT files must be updated to resolve issues related to
the generation of printed documents. The description of the fix does NOT
specifically state that it fixes this particular problem, but it

does...

As it turned out, I had installed this fix several months back . My co-
worker did not. Consequently, the project generated documentation fine
on my machine, but my co-worker was getting the boxes with the red X
for every image in the document.

As soon as I applied the printed documentation patch and overwrote the
old DOT files in RoboHelp on her workstation, she was able to generate
the printed documentation, and the images showed up just fine.

(17 April 2019 - That patch does not seem to be available any more but
this has not been an issue for a long while.)

Peter Grainge Note: These patches are for X5.

Another cause can be after you have imported a Word document. Word
puts the images in a sub-folder but that does not get created in

RoboHelp. Look at your project in Windows Explorer and verify the images
are in such a sub-folder. In RoboHelp, right-click the topic and select New
| Folder. Create a folder with exactly the same name as in Windows
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Explorer. You will see the images getting added to the folder and you can
leave them there or move them.

Printed documentation
error messages

If you get one of the first three messages below, you could try reducing
your security level to Medium (In Word, go to Tools | Options | Security |
Macro Security). Obviously you must only do that if permitted by your
company's policies.

1. The file contains macros with an expired or revoked signature.? Since
you are running under High Security Level, these macros will be
disabled.

2. The macros in this project are disabled. Please refer to the online
help or documentation of the host application to determine how to
enable macros.

3. The Word VBA macro version registered is incorrect. Please reinstall
printed documentation.

4. Microsoft Word has encountered a problem and needs to close. We
are sorry for the inconvenience.

5. Unable to generate Printed Documentation. Please contact technical
support.

VBA Macro Version Update 14 Feb 2014

Adobe sent me these instructions that worked for one customer using
RoboHelp 11 and Word 2013. Click here to download the file.

- Take a backup of the registry by running 'regedit’.

- Select 'Computer!

- Use option File > Export

- Save the reg file so that it can be restored if necessary.

- Extract macro_version.reg from the downloaded zip file.

- Double click the file to run it.

The registry will be amended and should allow you to generate printed
documentation.

Do not use this fix if you are not familiar with working in the registry
and / or if your company policies do not permit you to make registry
changes. See assistance from someone qualified.

Images printing upside
down and reversed

See Item 17 in Snippets -Features and Use.

Word has not been
started on this
computer.

Mike Walsh reported this problem even though Word has been used. He
found opening a RoboHelp for Word project fixed it. Seems like a missing
registry entry that opening RoboHelp for Word fixed.

It can also occur when your IT department has set up your profile on a
network drive. Olaf found a solution for this problem. In Word > Tools >
Options > File Locations he changed the location for the "user templates"
and "startup" to a folder he created as c:\robohelp\startup. Then he
copied the RoboHelp Templates (PrintDoc.dot, Style Mapping.dot and
RoboHook.wll) to the new "startup" folder and started Word so that the
RoboHelp templates were active.

Next he started RoboHelp HTML and tried to generate printed
documentation. For a short time he saw a message "waiting for register
VBA macros" and then the printed documentation worked. Finally he
changed the path back to the original roaming profile folders and the
printed documentation still worked.
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The Document Wizard
cannot locate
Microsoft Word. Please
install Microsoft Word
before generating
printed
documentation.

Al Scott reported he came across this one when using a new computer.
Quite simply Word had not been used and had not been through its initial
startup processes. He opened Word, completed the few fields of
information required and then RoboHelp was happy.

Topics created with a
message No Data

Hadjira posted on the RoboHelp forum working with Word 2003 the
printed output wasn't created properly. The created file only contained
topic titles and instead of text there was a message "No Data".

After investigation Hadjira found the cause. "In one of my projects
containing two Word documents, one was printed fine and the second was
not. After a long research I found out the difference between those
documents: in the second one, the option "automatically update
document styles" was activated in the menu Tools - Templates and Add-
Ins. I switched the automatic template update off and it worked fine.

Topic footer appearing
in body of printed
document

We know that topic headers and footers do not carry across to printed
documentation. One person found though that his footers were appearing,
not in the footer section but at the bottom of the body of each page. He
didn't want the footer at all, much less there. Again it took a lot of trial
and error before I began to associate the problem with the item below
"Table borders missing and / or duplicated". When those meta tags were
removed, the footer stopped appearing!

Tables overrun the
margins

When RoboHelp generates printed output, it sends tables to Word as the
defined width unless that width is greater than the width between the
margins. Then it does the following:

If there are no merged cells, the table is scaled to fit the width between
the margins.

If there are merged cells, the table does not get scaled and overruns the
margins.

Numbering continues
instead of restarting at
1

Earl Eddings had a problem when generating very large documents. For
the most part his lists were correctly starting each list at 1 but towards
the end of large documents the numbering did not restart.

His solution was simple albeit I don't doubt it took some time to work it
out. Immediately before each list, Earl enters a line of text such as
"Follow these steps" to which he applies a style called Num-Heading. Then
he creates the list and applies a style called Num-Text. Both Num-Heading
and Num-Text are set up in the CSS he uses and are just paragraph styles
with no numbering applied, the nhumbering is applied using the RoboHelp
numbering icon.

When Earl generates his printed document he maps those styles to a style
he has added to his Word template, call that whatever you like,
something like rh_list_temp makes it easy to spot.

Earl's Word template also has two important styles set up called Num-
Heading also called Num-Text, the same names as in the RoboHelp CSS.
The Num-Heading style in Word has been set up to have a multi-level list
attached to it. This needs to be set up in Word 2003 as Word 2007 and
2010 handle multi-level list numbering in a different way. It should be
possible to set up an equivalent method if you only have access to Word
2007 but I didn't go into that.

These are the screenshots that Earl sent me showing how the list is set
up.
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Customize Outline Humbered List

Mumber Format

Level Mumber format;
| | |
2
3 Murnber skyle:
g (none) w |
& Presvigw
7 )
g Mum-Heading
:
1. Mum-Text
Mumber position i)
sreawps 3 | O

Text position ':':'
Tab space after;

05" % Indent at: |0,5" e

Link level to style: pv | [ ] Legal stvle numbeting

|Num-Heading

Followe number with:

Tab character w

Listhurn Field list name: |r'-.lum-Heau:|in|;| | pply changes to: |'u'-.-'hn:-le list w |
Customize Outline Numbered List E'
Tt

Level Mumber format:
el |
EX
g 1,2,3, ... 1 %
] Previous level Preview
7 :
g LT SE Mum-Heading
g | W | Eort. .. 1. Hum-Text
Mumber position i)

: . . 1)
_nght w Aligned at:|0.78 (
(a)

Texk position (?
Tab space after: é
0,59 x Indert at: |0,59" i
I Link lewvel to skyle: Kum-Texk vlll:‘ Legal style nurbering
Followe number with: |Ta|:| character L Restart numbering after: | Level 1 L7
ListMurn field lisk name: |r'-.lum-Heal:|in|;| | apply changes to: | Whale list w

Notice the first level is tied to Num-Heading and has no humbering and
the second level is tied to Num-Text.

Once the document has been generated, Earl uses Word's find and
replace to find all instances of the rh_list_temp style and replace them
with the Num-Heading style. As Word does that, it corrects any lists that
have continued numbering instead of restarting.

If you have Word 2010, that requires you to have RoboHelp 9 where there
is an easier solution. Instead of using single level lists convert all your
lists to multi-level lists even if you only use the top level. The reason is
simple. RoboHelp 9 allows you to map RoboHelp multi-level lists to Word
multi-level lists. Because of the way Word works, all lists will start at 1
and ignore any numbering restarts you have set up. If you wanted lists to
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restart numbering, that would be a problem (as described in the Printed
Documentation section of multi-level lists) but for this purpose, that
problem becomes a solution!

UPDATE 16/01/12

Caroline Wilson recently sent me a PDF file with her procedure which is
very similar and I understand it also avoids the need to find and replace
the styles. Click here to download Caroline's steps. They are nicely
documented with screenshots.

Other Issues

Issue

Description

Unable to generate a
document for none of the
above reasons

Nested Tables

One poster was unable to generate a document even after going
through all the options listed elsewhere in this topic. The cause was
eventually tracked down to some nested tables and once these were
removed, the document could be generated.

This does not mean that you cannot nest tables and print, just that
if you have a problem, then consider this as a cause. You might be
luckier.

Virus Checkers
Check your anti-virus program settings.
Norton:

Norton has a script blocking feature that can be set to Stop All
Suspicious Activities. After changing that to Ask Me What To Do, and
authorising RoboHelp's scripts, another poster was able to generate
printed documentation.

McAfee:
Craig Clarke posted the following:

This is a specific problem with Robohelp and McAfee when trying to
generate printed output.

1. Open McAfee Security Centre.
2. Got to the Virus Scan tab.
3. Click on the Configure Virus Scan Options link.

4. On the Active Sheild tab there is an 'Advanced' button right at
the bottom of the window.

5. Click on the Advanced button.
6. Click on Exploits
7. Uncheck the Enable Script Stopper checkbox.

I have found no other suitable way to do this with McAfee and spent
hours fiddling around with options. Just adding robohtml.exe to the
trusted applications did not work. Personally, I only uncheck this
option when creating printed output as it obviously compromises
security. I've had similar problems with other Help Authoring Tools
when generating printed output and I suspect it is to do with the
integration with Word.

Style in output is not the
same as in the source

This can occur if you have used more than one style sheet in your
online help and they have different definitions for say the <p> tag
and then you map to a Word template. You have effectively told it to
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use the style in the template rather than the source and there is
only one version of the style there.

Table borders missing and /
or duplicated

I found this using RoboHelp 7 whereas I had not had the problem
before. Some borders were double thickness in the printed output
while others were missing. In the online help, there was no
traceable problem.

The cure seemed to be removing two meta tags. The topic had been
created from a Word import and these two tags had been added by
RoboHelp:

<meta name=0riginator content=ImportDoc>
<meta name=0riginalFile content="filename.doc">

As soon as I removed those tags and generated again, the problem
had gone.

I later found that viewing a document with the problem in Word
2007 cured it. Open the same document in Word 2003 and the
problem was still there.

Dropdown text not
formatted as specified

If your dropdown text is formatted to be in italics, you will find that
it does not survive the trip to printed documentation, even if you
have mapped to a Word template where the style is formatted as
being italic. I took this up with Adobe and they advised that it is
because of a bug in Word.

I then found a bizarre workaround. Add a row of asterisks in the
paragraph before and after the dropdown text as below and then
generate your printed document. You don't like that in your topics or
documents? Not a problem. After you have generated once, you can
go back and delete the asterisk and the dropdown will still appear in
italics!!

3k 3k 3K 5K >k 3k 5k >k K 5K >k 5k 5k >k 5k 5K 3k 5Kk >k 3k 5k >k K 5k >k 3k 5k >k K 5K K 5k 5k >k 5k 5k >k 5k %k k

Dropdown text

3K 3K 3k 5K 3K 3k 5k 3k 3K 5K 3k 5Kk 5K >k 5Kk 5K 3k 5Kk >k 3k 5k K K 5k K 3k 5k >k 3k 5K %k >k >k %k >k >k k >k %k k

The other option is to use a colour for you dropdown text as that will
survive the trip.

Content of tables is not
formatted correctly in Word
/ PDF outputs

You have put some content in a table that looks OK in the Design
Editor and in online outputs but is incorrect in Word / PDF outputs.
Here's the explanation.

RoboHelp's table editor requires you to define the font and style for
the content. If you look at the Edit tab in the ribbon you will see
your CSS file selected but the style field will show None. The HTML
written for any online outputs will show whatever you have defined
for the table style but it does not work for printed documentation,
be it Word or PDF. Fortunately, there is a solution.

Font in printed documentation to be same as
OLH

If the font and font size are to be the same in the printed output as
in the online help, it's simple. Simply select the content of the table
and apply the style(s) you want from the styles in the dropdown.
You can use just one style or many. When you generate the printed
documentation those styles will hold.

Font in printed documentation NOT to be same
as OLH

Perhaps you want your online help to be 12 point but only 10 point
in printed documentation or you want a different font or font colour,
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all quite normal requirements. This requires rather more work. The
time is in the initial setup and after that, it is easy.

The first thing to note is that to overcome this problem is that in the
print dialog you must map to a Word document, even if you are only
generating a PDF. This option will not work if you select to map to a
CSS as no mapping of individual styles is available. These are the
steps I use.

1. In RoboHelp's Style Pod, select Edit for the table style you are
using. Change the colour of the font to red. If you have existing
topics using the table style, you will see at this point the text is
now red.

2. In your CSS, create the styles that you can apply to the content
to override the default red. I suggest table_heading and
table_text. Define them as required for the online outputs.

3. Go through all your topics that use the table style and override
the content with these styles.

4. Whenever you create a new topic that uses the table style, as
soon as you enter any content it will be in red signalling that
you need to apply the required styles.

5. When you generate online help, the appearance will be as
defined for the new styles.

6. The first time you do this at least, check all topics in the output
for red text to make sure you did apply a style from the
dropdown. Ideally always check all topics to make sure you
didn't add a new topic and somehow miss the bright red!

7. For the printed documentation you now need a Word template
set up. This is what takes time to set up initially. I suggest you
open the supplied Rh Style Mapping template. The reason I
suggest editing the supplied template rather than using your
own is because of problems I have seen over the years. People
report a problem that goes away when they use the supplied
template rather than their own, even though apparently their
template is good. It may not be logical but it is fact.

Edit the existing styles as required but ignore any existing Table
Text styles. The template can be found in the root of your
project and I suggest you keep an unedited backup somewhere
safe.

8. Create two new styles. Here the naming is important. Assuming
you created table_heading and table_text in your CSS, create
something like Table Heading XX and Table Text XX where XX is
something to help you and any other authors readily identify it
when mapping. I used the company initials. Using the existing
styles will not work.

9. Now open the Printed Documentation layout and work through
it until you get to the last page. There you must select mapping
to a Word template and select the template you have edited.

10. The styles used in the the topics are displayed on the left and
should be mapped to the styles in the Word template on the
right. The important bit here is to map table_heading and
table_text to the new styles in the template, Table Heading XX
and Table Text XX.

11. Generate your printed output, be it Word or PDF or both and it
should be displayed correctly.

If you feel this should be easier, please submit a feature request. My
own view is that the table editor should not require you to define the
styles for the content because those definitions cannot be mapped
when generating printed documentation. Instead it should allow you
to select styles that are in your CSS already. It would not affect the
online output but it would solve this problem.
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Please follow this link to submit a feature change. The more people
who do so, the higher it gets prioritised.

Donations

If you find the information and tutorials on my site save you time figuring it out for yourself and
help improve what you produce, please consider making a small donation.

Topic Revisions

Revisions
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